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You can use 12/24 Hour Time to set the Control Panel clock to 12 or 24
hour time. This does not affect the way files are dated, only the way
the time is displayed in the Control Panel window.

2.2.2 CPX Mover and Reload CPXs.

Only active CPXs are loaded during startup. All active CPXs appear in
the wain Control Panel Window. If you need to use an inactive CPX, you
can use the CPX Mover to change the status of the CPX from inactive to
active. Then when you select Reload CPXs, the newly active CPX will
display in the main Control Panel window.

You can also remove a CPX from the main Control Panel
changing the status of the CPX from active to imactive.

To change the status of a CPX, follow these steps:

1 Open the Control Panel. Select Setup from the Options menu. A W

2. Select the CPX Mover. The CPX Mover window displays.

Window by

3. Select the desired CPX by positioning your pointer over the name
of the CPX and clicking. The CPX highlights, and the appropriate
operation appears in the Move box.

Note: You can select multiple CPXs for the move CPXs operation. Use

the shift-clicking or rubber banding to highlight more than one CPX.

If you use rubber banding, the rubber band box will not actually

appear, but it still works the same way.

4. Select the operation by clicking in the Move box.

If you have transferred a CPX from imactive to active status, you -=uﬁA, il

reload before you can use the CPX. To Reload CPXs, follow the steps:

1. Open the Control Panel. Select Setup from the Options menu.

2. Select Reload CPX. When the confirmation dialoque box appears,
select OK.

2.2.3 Advanced Setup Options.

Setting the MWinimum Number of Slots and the CPX Directory Path are
advanced features of the Setup dialogue box. You will probably use
these options infrequently.
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CPXs are stored on an external memory device (hard disk or floppy
disk). During startup or reloading, only basic information about each
active CPX (such as the CPX’s name and icon) is loaded into RAM. When
you actually open an active CPX, the bulk of the file is then loaded
into RAM so you can use the CPX. When you close the CPX. the file is
erased from RAM until the next time you open it.

Note: CPXs with Resident status do not follow the above pattern, but
are copied into RAM at startup time.

When you set the Minimum Number of slots (5 to 99), you are reserving
enough RAM to be able to store basic information for that number of
CP¥s. If the number of active CP¥s at startup time exceeds the Minimum
Number of slots, enough RAM for that number of CPYs is reserved.

2.2.4 CPX Directory Path

The CPX Directory Path tells the Control Panel where to look for CPX
files. You will probably want to store all of your CPX files in one
folder, and set the directory path to that folder. But if you store
CPX files in more than one place, the CPX Directory Path must be set
to the directory that contains the CPX files you wish to use.

Note: If the CPX Directory Path is too long to display in the box, use
the left and right scroll arrows to display the hidden sections of the
path.

To change the CPX Directory Path, open the Control Panel and select
Setup from the Options menu. Click anywhere on the CPX Directory Path
box and the file Selector displays. Use the File Selector to select a
new path. When you open a directory, the directory name is added to
the File Selector’s Directory line. When the desired directory path is
displayed, select OK. The new path will appear in the CPY Directory
Path box.

2.2.5 Open CPXs

You can open a CPX by first highlighting the CPX on the Control Panel
main window, and then selecting Open CPXs from the Control Panel
Options menu. You can also open a CPX by double clicking on its box in
the Control Panel main window.

2.2.6 CPX Info

When you highlight a CPX and then select CPX Info from the Control
Panel Options menu, the CPY Info window displays. The window contains
the selected CPi’s filemame, version number, ID number, and
Resident/Non Resident status.

Filename is the CPY’s actual filename as it appears on the disk,
Version and ID are assigned by the CPX’s programmer. Two versions of
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|1 Introduction

This w®anual is a supplement to the manual for your existing 105 and
gives details of new features in TOS 2.06. It is not a definitive
quide to TOS but should be read in conjunction with your original
manual.

1.1 Desk Menu

The desk menu is divided into two sections. The top section usually
contains a single entry which, when selected, displays information
about the application you are working with.

The lower section lists your active desk accessories. To be active, a
desk accessory file must have the extension .ACC and must be on the
root directory of drive C (or on a floppy startup disk in drive &)
when you switch on the computer.

Switching on the computer without active desk accessories frees some
RAM and displays the desktop faster.

When you display the Desk wmenu from the desktop, the top section of
the menu lists the Desktop Info option. If you select Desktop Info, a
window listing GEM and TOS copyright data displays.

1.2 File Menu

The File wmenu contains options for opening and closing directory
windows, selecting all displayed files and folders for an operation,
deleting a file or folder, creating a folder, formatting disks, and
wore.

1.2.1 Open

The open command can be performed on a disk or cartridge icon, folder,
or file, printer icon, or trash can icon.

NOTE: An alternative to using the Open menu command is to position the
pointer over the icon you wish to open and double-click the left wmouse
button.

1.2.2 Show Information
When you highlight a floppy disk, logical drive, folder, or mw_m icon
and select the Show Info option, the screen displays information about
the highlighted item.
In the Disk information dialogue box, the number of bytes used plus
the number of bytes available for a floppy disk or logical drive does
not always equal the exact total storage capacity. This is because nam
computer allocates space for each file in fixed-size blocks, even if
the file does not completely fill the last block. The Bytes Available
information is an indicator of available unused storage space.
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When you select Show Info for a file or folder, the dialogue box
displays the following information:

Path The top line lists the complete path of the file or
folder. If the path is too long to display on the
line, you can use the scroll arrows to reveal the
hidden part of the path-name.

Name The name of the folder or file. The text insertion
cursor appears to the right of the name. To change
the name of a file or folder, press [Esc) to clear
the name line. Type in the new name, using eight
characters or less. Type a period, then the three
character file extension (usually not used in folder
names).

Size Size, in bytes of the file or folder. Folder size is

the total number of bytes used by all the files
within the folder.

Date The date the file or folder was last modified.

Time The time the file or folder was last modified.

No of Folders The number of folders within the folder. This only
applies to folders.

No of files The total number of files within the folder,

including files within other folders. This only
applies to folders.

Attribute The choice for files is Read Only or Read/Write.

1.2.3 Search

The search command perforas a file search on a floppy disk, logical
drive, or folder. You must set the parameters of the search by typing
in the name of the file for which you are searching. You can also type
in part of a filename and Search will match the typed characters. For
example, if you wish to search for all files with the extension .bac,
type a full stop, then type DOC. Search opens the window containing
the first .DOC file it finds and ask you if it should continue the
search. If you select OK, Search will use the same window to show the
next .DOC file, and so on. When Search can find no more .DOC files, an
alert box displays to let you know that no more files are to be found.

Before selecting Search, you should highlight the floppy disk, logical
drive, or folder upon which you wish the search performed. If no item
is highlighted, Search will perforn the comsand upon the active
window. If there is no open window on the desktop and no highlighted
item, you cannot select Search from the menu.

NOTE: The Search dialogue box 4mwmmwiw~ highlighted icons.




1.2.4 Delete
The Delete command deletes all highlighted files and folders.

1.2.5 Create Folder

The Create Folder command creates a new folder in the active window.

NOTE: Certain characters cannot be used within a folder name or
extension,

1.2.6 Close Directory

The Close Directory command closes the top level of the active window.

NOTE: you can also close a directory by selecting the close box in the
window’s upper left corner.

1.2.7 Close Top Window
The Close Top Window command completely closes the active window,
including all levels of folder windows and the main directory window.

1.2.8 Bottom to Top

When you select this command, Bottom to Top brings the bottom window
to the top of the stack and displays it as the active window. The
current active window is sent to the bottom of the stack.

1.2.9 Select All Items

The Select ALl Items comsand highlights all files and folders in the
active window. The files and folders that are hidden, but would be
shown by scrolling, are also selected. However, files that are in the
directory but do not match the file wmask parameters are not selected.
(See "Set File Mask").

NOTE: If the file Mask is *.*, then all items, including all folders,

are selected. If the File Mask is set to show a selected filename or
file extension or both, folders will not be selected.

1.2.10 Set File Mask

The Set FPile Mask command allows you to choose the file type to be

displayed in the active window. When you select this command, the Set

Pile Mask dialogue box appears. You wmust fill in the file type

parameters, both file name and file extension.

Por example, if you want only those files beqginning with the letters

"DESK" to appear in the directory list, you would press escape to

clear the Name line. Then you would type DESK *.* and select OK. The

first asterisk after the word DESK means that any file with characters

in the filename following the letters DESK should be displayed. The

asterisk is known as a wild card character.

The default file wask parameter is an asterisk for the filename and an
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asterisk for the extension. This means all files are displayed.
NOTE: Folders are not affected by Set File Mask.

The parameters selected for the open window remain in effect as long
the window remains open. Once you close the window, the parameter you
chose are cleared.

1.2.11 Format Floppy Disk

All &mwm formatted with 105 2.06 can be read by IBH PCs and
compatible computers using MS-DOS 3.2 or later.

1.3 View Menu

The View menu lets you choose the way your computer displays files and
folders.

NOTE: When you save your desktop, TOS saves all the View menu choices

you made to the MNEWDESK.INF file on your startup disk (See "Save
Desktop").

NOTE: A ﬂ.lm:_ﬁm symbol appearing next to a file name indicates a
read-only file.

1.3.1 Sort by Name|DatelSizel Type

It is sometimes necessary for you to have a list of your files and
r.:%n ._z‘mmm—_nmﬁ_ in a certain order. Folders as a group are always
listed first, followed by files.

1.3.2 Size to Fit

When you ...,..m_mon Size to Fit, all icons are displayed in horizontal
rows starting at the top of the window. Each row is only as wide as
the m“__:_%: and will automatically resize whenever the window is
resized.

1.3.3 Set Colour and Style

mmn. Colour and Style allows you ‘to create a unique desktop
m_.z:o_d-m__ﬁ. You can use Set Colour and Style to choose a colour and
fill pattern for both your desktop and for opened windows. When you
select Set Colour and Style, the following dialogue box appears:
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SET COLDR AND STYLE

Set: [[EERETN [Window |
il I

] [Cancel]

n&oEmz: dialoque box

In the example the Desktop box is highlighted. This allows you to
wodify your desktop display. To medify the window display, the Window
box must first be highlighted.

1.4 Options Menu

The Options menu includes commands that allow you to save your desktop
confiquration, install icons, applications, and devices, print and set
your screen resolution.

NOTE: When you save your desktop, T0S saves all the Options wmenu
choices you wmade to the NEWDESK.INF file on your startup disk. Use
Save Desktop to save changes made with Options wmenu commands (See
"Save Desktop").

1.4.1 Install Icon

Install Icon allows you to choose the shape of your window and desktop
icons. The DESKICON.RSC file on your C drive or floppy startup disk
contains a collection of detailed icon shapes. You access this file
through Install Icon. Choose from a variety of icons to create an
interesting and entertaining desktop.

You can also use Install Icon to change a floppy disk’s or logical
drive’s icon identifier and icon label.

When you select Install Icon from the Options menu, the select icon
type dialogue box displays. You can select either Desktop or Window.

“Please select fcon type.

o

|Desktop| [ Window | [Cancel |
, Icon selection dialogue box
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cmmxnoﬂ lcons are device icons (printer, floppy disk drive, logical
drive, and cartridge), and the trash can icon. Window icons are folder
and file icons.

1.4.1.1 Desktop Icon

When you select Desktop (icon), the following dialogue box displays:

IKSTALL DESKTOP ICOM

|

|

| Icon Identitier: |:
| Icon Label:

Icon Type:

| Icon Shape: @ @

(o ] (k0o ] (Cancel ]

Install desktop icon dialoque box
To install a single desktop icon, follow these steps:

1. If you are installing a floppy disk or logical drive icon, type
the drive letter. Press [Tab]

2i Type in the name of the floppy or logical drive. You can use up
to 12 characters. This step is optional; you do not have to
assign labels (names) to your desktop icons.

3. Position your pointer over the type of icon you wish to install:
Drive, Trash Can, or printer (See "Using an Installed Printer
Icon"). Click the mouse button once.

{. Use the scroll arrows to scroll through your icon choices. When
the desired icon displays, select OK to install. The icon
appears on your desktop.

You can also assign an icon shape to a group of desktop items.
NOTE: If you do not wish to assign a new icon shape to an item in the

selected group, select Skip when that item displays in the dialogue
box. That item will retain its current icon shape.

1.4.1.2 WINDOW ICON

There are two ways in which window items can be displayed in a window:
text and icons. You can assign icon shapes to window items that are
currently displayed as text, but the assigned icon shapes will not
display until Show as Icons (under the View menu) is selected.

You can assign icon shapes to: a single window item (file or folder),
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a qroup of window itess, or a specific file type.

| INSTALL WINDOM ICOWS

Hame: |

Icon Shape: '3
_ co p @‘ T.

File Type: |FOLDER | [@443

| [Install] [Renave ] [ Skip ] [Cancel]

Install window icon dialogue box A
Note: If you do nmot wish to assign a new icon shape to an item in the
selected group, select skip when that item's nase mnn current icon
displays in the dialogue box. That item retains its current icon
shape. If you wish to remove the item’s currently mmm_mama icon mumwo.
select Remove. The default icon shape for that item type will
automatically be assigned to that item. ;
You can also assign an icon shape to a file type. After setting the
parameter to define the file type, mp_. the files that wmatch the
selected parameter will be assigned the specified icon shape.
Select the parameter the same way you would set a mm_m mask, ~<vm=a in
the parameters on the Name line of the Install window Icons dialogue
box. To assign an icon shape to a specific file type, type *. followed
by the extension (for example, *.FNT).

1.4.1.3 Changing the Iicon Identifier and Label

To enter a new icon identifier and label for an icon, follow these

steps:

1. Highlight the icon you wish to change. Select Inmstall Icon from
the Options menu. The Install Icon dialoque box displays. A

2. Type the new Icon Identifier letter and press [Tab]. If you wish
to retain the current drive identifier, press [Tab] to wmove the
text insertion cursor to the Icon Label line.

NOTE: the letters A and B are reserved for floppy disks, and the

lower-case letter c¢ is reserved for the cartridge slot. Upper-case

letters C through P represent logical drives. ‘

3. Press [Bsc] to clear the Icon Label line. Type in the new icon
label. You can use up to 12 characters. Select OK.
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1.4.1.4 Using an Installed Printer Icon

An installed printer icon can help you print files in the same way as
the Print command of the Show/Print dialogue boy. Drag and position
the desired files over the printer icon. If you have a printer
properly connected to your system, the information from the file will
be sent to the printer. Some files may print only coded or incomplete
information.

After installing a printer icon, use Save Desktop to save the
installation. The next time you switch on your system, the printer
icon will appear on your desktop.

1.4.2 Install Application
Using Install Application, you can:

Link an application to data files with a specified extension. You can
then process those data files (documents) directly from a window
instead of having to open the application first.

Select an autoboot status for any application, so whenever you switch
on your computer the application opens automatically.

Assign a function key to open an application.

Specify what default directory to use for a specific application.

The assigned default directory takes precedence over the defaults
assigned by Desktop Configurations.

Specify full path or filename to an application. The specification
takes precedence over the defaults assigned by Desktop Configurations.

Assign arquments to programs.
1.4.2.1 Arguments

When you open a program file, you are telling the computer to follow
the imstructions in that file. The instructions within the prograe
file then take over and run the show until you exit from the program.
Sometimes you need to give the program additional information, such as
what to do with a data file. This additional information is called an
arquaent.

Most programs provide ways for the user to imput arquments, such as an
Open file command in a word processing program. In fact, if you input
the name of an existing data file in the Arqueents line, and you have
your input parameters set in such a way that the program can find the
file, the data file will open automatically when you open the word
processing program. But unless you work on one data File almost
exclusively, other options such as linking an application to a data
file type make arquments of this kind cluasy and unnecessary.

}naz-muﬂmm~m=mma-omﬁ mmmn 1¢~u utility programs. These programs




often need complex additional instructions such as a code sequence to
determine which part of RAM will be wused to contain the program
instructions. Detailed explanations of the arquments needed, and the
correct syntax for those arquments will be included in the program’s
documentation.

When you open the Install Application dialogue box, the text insertion
cursor is already on the Arquments line. Simply type the arqueents and
press [RETURN]. Remember to use Save Desktop to save the arqueent,
otherwise it will be erased when you switch off the computer.

1.4.2.2 Linking Document Type to an Application

You can use Install Application to link a data file type to an
application. Choose the file type most commonly wused by the
application. After linking the application with the document type, ﬁam—
linked application automatically opens when you open the document fro
the desktop.

NOTE: you must pay particular attention to assigning correct default
directories and parameters to an application when linking a docusent
type to an application. This is especially true when you open the
application from its icon on the desktop. Refer to the application’s
documentation for detailed information on correct default directories
and parameters.

To use Install Application to link an application to a data file type,
display the window containing the application you wish to link to a
docusent type. Highlight the desired application. Select Install
Application and the name of the selected application appears in the
Install Application dialogue box.

NOTE: You can select wore than ome application at once for this
operation. Highlight all the applications you wish to install, then
open the Install Application dialogue box. After completing the
operation on the first selected application, the name of the second
selected application appears in the Install Application dialogue box.

NOTE: When installing wultiple applications, selecting Skip will am:mu
Install Application to skip over the application whose name I
displayed on the Application name line. ALl current settings will be
retained.

1.4.2.3 Selecting a Default Directory

Every program that works with supporting files (such as resource files

or help files) has to have, as part of the program, a way to look for

those files. Desktop Configurations tells your computer  which

directory should be the default. This is where the program will access

files if the program assumes that it is not installed. Using Install
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>wu_Hmmnwo= to assign a default directory to a specific application
overrides the Desktop Confiquration’s assignment for that application.

You can set the default directory to Top (active) Window, or
Application (the directory in which the program resides).

Some prograns do not look for files in any location other than the
default directory. For these programs, select Top Window, and make

mm&m that the program file and all supporting files are in the active
window.

1.4.2.4 Selecting Parameter

Before an open application can use a data file, it must first find and
open the file. Most programs enable you to search through all existing
directories to locate and open a desired file. These programs have no
preconceived ideas about the location of files. For these prograss you
would choose Full Path, so the entire pathname of the file is used
when a file is opened.

Other programs already have pre-existing partial paths. This means
that the program contains a partial pathname that it uses every time
the progran searches for a file. A partial pathname consists of the
drive ldentifier, and all applicable directories. Only the file name
and extension is input for the search. All files wust be in the
specified directory, or they canmot be located. Check your program’s
docusentation to determine the program’s default path, and make sure
all of your data files reside in the correct directory.

»hmg&m try w:p* Path first. Then if necessary, experiment with other
combinations until you find one that works with your application.

1.4.2.5 Installing an Application on an F Key

Any executable file (program) can be installed to open from a function
key ([F1] through [F10] at the top of the keyboard). You can install
up to 20 programs to open this way. Use [Fl] through [F10] for the
first ten programs, and ([Shift] [F1] through ([Shift][F10] for P11
through F20.

To assign a function key to open an application, highlight the
application and select Install Application from the Options wmenu.
Press [Tab] twice to move the text imsertion cursor to the Install as
Line m=@ type the number of the function key you wish to assign to the
application. Then select Install.

1.4.2.6 Autoboot or Normal Boot Status

If you mainly use your computer for a single purpose using one
mvmn_%_n mvu_bnmﬁuoj (such as a database, a word processor, or
graphics program), it will save time if you install that application
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to autoboot. An application installed to autoboot status will open

automatically whenever you switch on your computer.

Follow these instructions to install an application to autoboot or

return an application to normal status:

I Highlight the -icon or name of the application you wish to
install to autoboot. Select Install Application from the Options
renu. The Install Application diatoque box displays.

% Select the Boot Status: Auto box. (To restore normal boot status
to an application installed to autoboot, select the Boot Status:
Normal box.)

3 Select the appropriate Application type box and Select Install

Remember to use Save Desktop to save the selected boot status,

~.A.u__ahnmbns.nnm
The Install Devices command installs desktop icons for all hard &m_nﬁ
partitions on all properly confiqured devices. It also installs a
cartridge icon if a cartridge is in the cartridge slot during startup.

To saves your desktop confiquration in a file see Save Desktop.

1.4.6 Read .INF File

You can have more than one desktop information file on your hard disk,
each containing different information (such as installed desktop icons
and their placement, and all View and Options menu options). The Read
JINP  FPile command allows you to change to a different desktop

environment without having to transfer files or reboot.

The default NEWDESK.INF file is in the root directory of your C drive.
You can nawe the alternate desktop information files anything you
like, but the three character extension must be .INP.

NOTE: If you wish to save the current NEWDESK.INF file before using
the READ.INF command, simply change the name of the current file
NEWDESK.INF file. This allows you to save your desktop without losing

your current setup.

1.4.7 Desktop Configuration A
With the Desktop Confiquration dialogue box you can set the default
directory and input parameters for all applications, scroll through
assigned function keys, and assign a single keystroke to various menu
commands. The Desktop Confiquration dialogue box also displays the
amount of RAM still available.
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DESKTOP COMFIGURATION
Set default directory as:

TIEE Top Hindow
Set input paremeter:
E File Name Only

Function—key Assignments:

[~ =IF]
Define Single Keystroke:

Henu Iten:

[ opea... o1

Key: 0f [Clear 8I1]

Systen Free Memory: 1791578 bytes

&) [Cancer]
Desktop configuration dialogue box

Host applications use the default directory and input parameters
displayed in the Desktop Configuration dialogue box. The exceptions
are applications that have been assigned their own specific default
n*ﬂmnﬁonm and input parameters through the Install Applications
dialoque box. You can find detailed information regarding setting the
default directory and input parameters under "Install Applications".

You can use the Function-keys Assignment to display the full path-name
of each program that has an assigned function key. Use the right and
left scroll arrows to display hidden parts of the path-name, and the
up and down arrow keys to scroll through the assigned function keys.

All wmenu commands can be assigned a keystroke. This enables you to
bypass the menu bar and initiate the command by pressing a single key.
Use Define Single Keystroke up and down arrows to scroll through the
menu commands and their keystroke assignments. To change the keystroke
f a displayed menu command, type in the desired keystroke. To clear
all menu command keystroke assignments, select Clear All.

System Free Memory displays the number of bytes of RAM still
available.

After making changes to the Desktop Configuration dialogue box, select
OK to confirm your choices. Use Save Desktop to save your selections,
or they will be erased the next time you switch off your computer.

1.4.8 Save Deskiop

Use save desktop to save the current arrangement of Windows and Icons
as well as Option and View wmenu selections. The saved confiqurations
and menu selections are stored in a file called NEWDESK.INF on your
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startup disk or hard disk drive root directory.

How you arrange your desktop will depend on your needs, but it's
usually a good idea to place the trash can icon away from the disk
drive icons to protect against unintentionally dragging files to the
trash can instead of to a disk or logical drive icon.

Arrange directory windows on the desktop by opening, wmoving, and
sizing selected windows. You can have up to seven directory windows
open at once on the desktop. Select options frow the View menu to
determine how windows items (folders and files) will be shown (as text
or as icons) and sorted (by name, date, size, or type). If you show
window items as text, you may want to narrow the windows to show only
the item’s name and extension.

If you leave the windows open when you save the desktop, those windows
will open to the same size and position the next time you switch
the computer. The window that is active when you save the desktop wili
be the active window the next time you switch on the computer.

The size and position of closed windows is also saved when you select
Save Desktop. The next time you open the window, it will open to the
size and position it occupied on the desktop the last time was openmed.

1.4.9 Print Screen

The Print Screen command lets you .print the current screen display.
Everything showing on the screen prints. To use this command, you wust
have a graphics printer connected to the computer which has been
installed from the Control Panel. If you are using an Atari SLH Laser
Printer, the program SDUMP.PRG wmust be in the Auto folder on your
startup disk.

1.4.10 Blitter

The Blitter co-processor chip in some ST computers greatly improves
the speed of text and graphics displays. This chip can be turned or
off by selecting the Blitter option from the Options menu. When there
is a tick next to this option, the Blitter is turned on. When there is
no tick, the Blitter is disabled. In most cases, you will want to udma
the Blitter on.
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2 The new Control Panel and the CPXs.

The Control Panel co-ordinates many smaller programs called control
panel extensions (CPXs). The initial Control Panel screen displays the
names of all currently loaded CPXs. You can open a CPX by positioning
the pointer over the desired CPX and double clicking.

The Control Pamel also contains a pull down Options wmenu. When no CPX
is highlighted, the Options menu displays two menu choices: About and
Setup. Two additional Options menu choices display when a CPX name in
the main Control Panel window 1is highlighted. The three additional
options are Open CPX, CPX Info, and Unload CPX.

@ To select an option, position the pointer over the Option wmenu. Then

click the mouse button. The Option menu displays. Move the pointer
until the desired option highlights. Click the mouse button to select
the highlighted option.

2.1 About...
Gives information on the control panel software.

2.2 Setup...
You can wuse the Setup dialogue box to change a CPX’s status
(active/inactive), reload CPY¥s without restarting the ST/STE, set the
amount of memory reserved for basic CPX information, and designate a
CPY directory path. You can also use the calendar and clock to set the
time and date.

Tine

H 23/86/92

: [ 74 Hour | Hinimuwm Humber
i 0f Slots:

12/24 Hour Time
Reload CPXs

CPX Mover

Hininum Humber of Slots

[ ¢ [C:\CPX\®.CP B
[ Save W 0K [ Cancel

CPX Directory Path

2.2.1 Date and Time

The computer uses the date and time to mark individual files with the
date and time they were created or revised. This feature is useful
when you want to determine which file was most recently changed or
created.

Page 17



You can use 12/24 Hour Time to set the Control Panel clock to 12 or 24
hour time. This does not affect the way files are dated, only the way
the time is displayed in the Control Panel window.

2.2.2 CPX Mover and Reload CPXs.

Only active CPXs are loaded during startup. All active CPXs appear in
the wain Control Panel Window. If you need to use an inactive CPX, you
can use the CPX Mover to change the status of the CPX from inactive to
active. Then when you select Reload CPXs, the newly active CPX will
display in the main Control Panel window.

You can also remove a CPX from the main Control Panel
changing the status of the CPX from active to imactive.

To change the status of a CPX, follow these steps:

1 Open the Control Panel. Select Setup from the Options menu. A W

2. Select the CPX Mover. The CPX Mover window displays.

Window by

3. Select the desired CPX by positioning your pointer over the name
of the CPX and clicking. The CPX highlights, and the appropriate
operation appears in the Move box.

Note: You can select multiple CPXs for the move CPXs operation. Use

the shift-clicking or rubber banding to highlight more than one CPX.

If you use rubber banding, the rubber band box will not actually

appear, but it still works the same way.

4. Select the operation by clicking in the Move box.

If you have transferred a CPX from imactive to active status, you -=uﬁA, il

reload before you can use the CPX. To Reload CPXs, follow the steps:

1. Open the Control Panel. Select Setup from the Options menu.

2. Select Reload CPX. When the confirmation dialoque box appears,
select OK.

2.2.3 Advanced Setup Options.

Setting the MWinimum Number of Slots and the CPX Directory Path are
advanced features of the Setup dialogue box. You will probably use
these options infrequently.
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CPXs are stored on an external memory device (hard disk or floppy
disk). During startup or reloading, only basic information about each
active CPX (such as the CPX’s name and icon) is loaded into RAM. When
you actually open an active CPX, the bulk of the file is then loaded
into RAM so you can use the CPX. When you close the CPX. the file is
erased from RAM until the next time you open it.

Note: CPXs with Resident status do not follow the above pattern, but
are copied into RAM at startup time.

When you set the Minimum Number of slots (5 to 99), you are reserving
enough RAM to be able to store basic information for that number of
CP¥s. If the number of active CP¥s at startup time exceeds the Minimum
Number of slots, enough RAM for that number of CPYs is reserved.

2.2.4 CPX Directory Path

The CPX Directory Path tells the Control Panel where to look for CPX
files. You will probably want to store all of your CPX files in one
folder, and set the directory path to that folder. But if you store
CPX files in more than one place, the CPX Directory Path must be set
to the directory that contains the CPX files you wish to use.

Note: If the CPX Directory Path is too long to display in the box, use
the left and right scroll arrows to display the hidden sections of the
path.

To change the CPX Directory Path, open the Control Panel and select
Setup from the Options menu. Click anywhere on the CPX Directory Path
box and the file Selector displays. Use the File Selector to select a
new path. When you open a directory, the directory name is added to
the File Selector’s Directory line. When the desired directory path is
displayed, select OK. The new path will appear in the CPY Directory
Path box.

2.2.5 Open CPXs

You can open a CPX by first highlighting the CPX on the Control Panel
main window, and then selecting Open CPXs from the Control Panel
Options menu. You can also open a CPX by double clicking on its box in
the Control Panel main window.

2.2.6 CPX Info

When you highlight a CPX and then select CPX Info from the Control
Panel Options menu, the CPY Info window displays. The window contains
the selected CPi’s filemame, version number, ID number, and
Resident/Non Resident status.

Filename is the CPY’s actual filename as it appears on the disk,
Version and ID are assigned by the CPX’s programmer. Two versions of

Page 19



the same CPX can have the same ID number. In this case, only the most
recent version will be loaded. If you have several versions of the
same CPX. you can look at the version number to determine which is the
most recent version.

You can use Confiqure CPXs (See Configure CPXs) to change the resident
status of a CPX. You will probably want most of your CPXs to have
Resident: No status. This means that the bulk of the program is stored
in external memory (hard or floppy disk) and only read into RAM when
you open the CPX. But if you have a CPX that you use frequently, you
nay want to give it Resident: Yes status.

Resident CPXs run more quickly, but may take up a great deal of RAM.

Note: When you change a CPX’s status you must reset your computer for
the change to take effect.

2.2.7 Unload CPX A
Unload CPX simply removes a disk resident CPX from the CPX list on the
Control Panel wmain window. You can use Reload CPX to place the CPX
back on the list.

3CPXs

3.1 Windows Colours
Window Colours allows you to assign different colours (depending on
the selected resolution) to different elements of the desktop windows.
You can assign colours to each of 15 elements of the active window and
5 elements of inactive windows.
Even though the ST/STE colour palette contains 4.096 colours in wmost
resolutions, the colours available depend on the selected resolution
(from 2 to 16 colours on the screen at any one time). You can use the
Colour Setup CPX if "you wish to create a custom set of available
colours. (See "Colour Setup"). You can also use the factory assigned
default colour set, or use function keys 1 through 10 to select one of
Window Colour’s pre-assigned colour sets.

¢
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You can choose four options for each window element. Border allows you
to choose the colour of the narrow border that surrounds each window
element. Use Text to choose the colour of any text or icon (as in the
case of the Full box) that appears within the selected window element.

Fill is the background colour of the selected element, and you can

also choose one of the eight fill patterns appearing directly under

the Fill scroll bar. The fill colour will appear in the selected
pattern.

The Mode box allows you to toggle between having text appear directly

on the fill pattern, and having text appear within a solid background

over the fill pattern.

When you assign active window element colours and then select Save or

OK, the new colours will display the next time you open a window. Any

window that was opened before will not reflect the new active window

element colours.

Before you assign window element colours, choose the colour set you

wish to use. You can: use the factory assigned default colour set,

press a function key (1 through 10) to wuse a Window Colours
pre-assigned colour set, or use Colour Setup to create a custom colour
set.

Follow these steps to assign active and inactive window element

colours:

1,  Select a window element for colour assignment. A box outlines
the selected element.

2. Click and drag the appropriate scroll box to assign Border, Text
and Fill colours to the highlighted window element. Click on the
desired Fill Pattern.

3. Select the desired Mode. Repeat steps 1 through 3 unfil all the
desired colours have been selected.

i, Choose Save to save the selected window element colours or OK to
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select and use the current colours until you reset. Cancel will
return to the Control Panel menu with no changes.

3.2 Colour Setup

Depending on your computer type, wmonitor type and the screen
resolution you have selected, up to 16 colours can display at one time
on your screen. You can choose the colours you wish to have displayed
from a palette of 4.096 available colours (except in ST High
resolution, which is monochrome only).

Colour Setup allows you to choose which colours from the colour

palette you wish to have available for use when you assign window
colours (See "Window Colours").

=i
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Think of the 4.096 available colours as a collection of pens. The Pen

Display Box can display up to 16 pens at one time. The number of pens

displayed will be the same as the number of colours your resolution is

able to display on the screen at one time. The number of pens that can
display in your resolution at one time is your colour palette of pens.

Different inks will display in the Pen Display Box as you use the Pen
Number Scroll bar to scroll through the different combinations of
pens. Each display will contain 2, 4, or 16 pens, depending on the
nusber of colours your chosen resolution is able to display on the
screen.

Follow these steps to modify the pens in the displayed bank:

1. Use the Pen Number Scroll bar to scroll through the available
pen collection (if applicable to the selected resolution).
Display the collection that contains the pens that most nearly
matches the pen colours you desire.

2. Select the pen you wish to modify by moving the pointer over the
desired pen and clicking the mouse button, or wusing the Pen
Number Scroll Box to display the number of the desired pen. A
black box outlines the pen selected for modification.

3. Now use the RGB Colour Tuning Scroll Bars to change the colour
of the highlighted pen.

§. After you wmodify the displayed bank as desired, select Save to
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permanently save the palette, OK to select and use the bank
until you switch off the ST/STE. Reload to display the most
recently saved defaults. If you wish to return the banks to the
factory set defaults, press [Clr Home].

Note: You can restore the currently displayed collection of pens to
the condition it was in before you opened it. Simply press [Undo]. Use
Reload to restore all pens.

3.3 Configure CPXs

Confiqure CPXs allows you to change the name, choose the displayed
text and icon colour, and change the RAM resident status of CPXs.

i CONTROL_PANEL
of L general Setup| - Mame Line

CPX Options

f o
Text Colour! [¢] 1 [%]
Icon Colour: el 4 |®
RAM Resident: Ho <f——RAM Resident Box

Save 1 | ] [Eancel]

To confiqure a CPX, you must first display the name of the desired CPX
in the name line. Use the left and right scroll arrows to scroll
through the CPX list.

When the Configure CPXs windows displays, the text insertion cursor is
already positioned at the end of the CPX Name Line. To change the name
of the displayed CPX, press [Esc] to clear the entire Name Line, or
press [Backspace] to erase one character at a time. Then type in the
new CPX name.

To select Text and icon colours, use the appropriate scroll arrows to
display the 16 different available colours. The name and icon
displayed on the Kame Line will display the selected colours.

You can also set the RAM resident status of the selected CPY. Position
the pointer over the shaded RAM resident box and click the wmouse
button. Move the pointer to highlight the desired status. Click the
mouse button to save the highlighted selection.

When the desired text/icon colour selection displays, and the desired
RAM resident status is selected, click on OK or Save.

Note: RAM resident status takes effect only at start up time and when
you change resolutions.

3.4 General Setup
The General Setup CPX allows you to set the Kkeyboard response and
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repeat rate, the wmouse double click response rate, and the audio
feedback. It also allows you to toggle on and off the CPU Cache option

and display system statistics such as T0S version number and amount of
available RAM.

Status Selectian Bex

Saind Saiaitism Box Keybsard Respoase Aate Slider

ot f—— Keyboard Repeat Rate Sllder

Bouble Click Speed Selectsr
Bouble Click Spead Test Bex

Blltter Selection Box——

3.4.1 Status

Select the Status box to display the T0S version number and date, and
the number of total bytes available.

3.4.2 Audio Feedback

The computer has two kinds of audio feedback, a click signalling each
keystroke and a bell signalling keyboard or mouse errors.

To control audio feedback, select the keytop button or the bell

button. A gray image means that the sound has been turned off. A clear
image means that sound is turned on.

3.4.3 Sound

If you want all sound turned off, position the pointer over the Sound
box. Click the mouse button. Move the pointer until the word Off
highlights, and click the mouse button again.

3.4.4 Keyboard Response

Every key on the computer keyboard responds when pressed, and every
key (except [Shift], [Control], [ESC], ([CapsLock] and [Alternate])
repeats its character if held down. The keyboard repeat controls how
nuch time it takes for the keys to repeat when they are pressed, and
how quickly they repeat after the repeat process begins.

The upper slider controls how soon a key starts to repeat.

The lower slider controls the speed at which the keys repeat once they
start repeating.

Test the new settings by turning the sound on, if required, and
pressing [Space Bar]. You will hear a click each time you press the

space bar. Listen to the clicks to judge the repetition speed of the
keyboard.
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3.4.5 Double-Click Response

You can adjust the computer’s response to double clicking.

After setting the double-click response, you can test the setting by
double-clicking on the Double-Click Response Test box. When you
double-click at the set rate or faster, the box will briefly
highlight.

3.5 Modem Setup

The ports labelled Modem on the back of the computer are RS232 serial
ports. By connecting a mwodem to the computer, you can communicate with
other computers. You can also conmect a serial printer or any other
RS232 device to the wodem ports.

The Modem Setup CPX lets you configure the computer’s modem ports to
work with your wodem or other serial device. Refer to the manual
supplied with your peripheral for specific information on which
parameters to choose. The parameters needed by the computer with which

you are communicating (the remote device) is known as the
communications protocol.

3.5.1 Serial Port Selector

The Serial Port Selector allows you to tell the computer which of the
available serial ports to recognise as active., Select the port you are
using for the connected modes.

3.5.2 Baud Rate
Baud rate is the speed at which data is transmitted. Baud, the
standard unit measure of transmission speed, is the number of signal
elements per second.

3.5.3 Parity

Whenever computers transmit data through telephone lines, there is a
chance that some of the information will become garbled due to
imperfections and noise within the lines. Parity is an error checking
procedure that computers use to examine information and determine
whether data was cleanly transmitted.

The parity bit is added to a group of bits to make the total number of
bits tramswitted odd or even. Transmission errors can be identified
when the number of bits in a group does not match the parity chosen
(odd or even). Depending on the modem and the remote device, you will
choose either None, 0dd or Even parity. (Refer to the manual supplied
with your modem for specific information.)

3.5.4 Bits/Char
Each character is stored in memory as one byte. Usually a byte is wmade
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up of eight bits. Depending on bits per character used by the remote
device, you may need to change the number of bits per character when
transmitting through the RS232 port.

3.5.5 Stop Bits
You will normally use 1 stop bit, but you may need to use 1.5 or 2.

3.5.6 Flow Control

You can choose between two flow-control protocols:  Xon/X¥off, and
Rts/Cts. Flow control protocols are procedures that allow your
computer and the remote device to signal one another when to start or
stop sending information. Choose the flow control supported by the
remote moden.

3.6 Printer Setup

Any program may access the printer confiqurations set by the Printer
Setup CPX. Por example, the Print Screen option under the Options menu
uses the printer setup information. Other utilities or applications
may not. Check the manuals supplied with your programs to see if a
program can use the printer setup information.

Note: You canmot configure an Atari SLM laser printer with the Install
Printer dialogue box. Instead, refer to the Atari SIM Printer Emulator
User’s Manual (supplied with the SLM laser printer) for instructions
on changing printer settings. If you have both an SLM and dot-matrix
or daisy wheel printer connected to your computer you may be able to
select the printer type within your application. If not, you must turn
off one of the printer driver prograss.

To configure your printer, display the Printer Setup CPX window.
Position your pointer over the shaded box representing the setting you
wish to change. Click the mouse button. Move the pointer over the
desired setting. When the setting highlights, click the mouse button
to select the highlighted setting.

3.6.1 Printer Type

The choices are Dot (dot wmatrix printers) and Daisy (daisy wheel
printers). Select the appropriate box for your printer.

3.6.2 Colour

The choices are B/W (black and white, or wmonochrome) and Colour.
Select the appropriate box for your printer.

3.6.3 Pixels/Line

Only dot matrix graphics printers use the Pixels/Line option. Pixel
means picture element. On dot matrix printers, a pixel is a dot. Dot
matrix printers print a certain nuaber of pirels per line when
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printing in graphics wmode. If you have an Atari dot wmatrix graphics
printer, select 1280. I[f you have an Epson, or Epson-compatible dot
matrix graphics printer, select 960. Both values assume an eight-inch
printed line.

3.6.4 Quality

Only dot wmatrix printers use the Quality option. Select Draft for
draft-quality printing. Select Final for letter or near-letter quality
printing.

In Draft wode, the printer may make only one pass of the print head
when printing. FPor darker printing, select FPinal. Keep in mwind that in
Final draft wmode the printer will generally make two passes of the
print head, thus taking twice as long to print the page.

Note: Do not select FPinal if your printer does not support near-letter
quality printing.

3.6.5 Paper

If your printer feeds paper automatically by means of a tractor or
single-sheet feeder, select FPeed. If your printer accepts only a sheet
at a time which you wmust insert wanually, select Single. The Single
option prevents the printer from printing beyond the end of a page on
documents longer than a single sheet.

3.6.6 Port

If you have a parallel printer, select Printer. Parallel printers
connect to the port marked Printer on the back of the computer. If you
use a serial printer, select MHodem. Serial printers connect to the
port marked Modem (the RS-232 port) on the back of the computer.

Note: For wmost serial printers, Xon/Xoff flow is set to oOn. This
setting enables the printer to signal the computer to temporarily stop
sending data so it can print data it has already received. (See RS-232
Confiquration earlier in this chapter.)

3.7 Sound Setup

The Sound Setup CPX allows you to adjust the balance, volume, bass,
and treble stereo sound output. To generate a tone to test the current
sound settings, position the pointer over the face icon and click the
mouse button.

All Sound Setup settings can be adjusted in two ways. You can use the
scroll arrows to scroll through every possible setting, or you can
click on and drag the scroll box from one setting to another.

The Balance setting determines the strength of the audio signal sent
through both the right and left speakers. You can adjust for an even

balance, or send a stronger signal through the right or left speaker.
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You can use the Bass and Treble settings to adjust the strength of low

and high register tones, respectively. The Volume settings adjusts the
volume of sound.

When the setting highlights, click the mouse button to select the
highlighted setting.

3.8 Accelerator

The Accelerator CPX allows you to adjust the speed at which the

on-screen  cursor responds to the wmovement of your wmouse. The
Accelerator also contains a screen saver. \

Mouse Rccelerator .|m=-= Fast

Screen Saver Box
Meden Recognition

—Screen Saver Delay Slider

There are three Mouse Accelerator setting: Off, Fast, and Super Fast.
Choose the Off setting if you do not wish to increase the response
speed of the cursor. Select Fast or Super Fast to increase the cursor
response speed.

To select a new cursor response speed, position the pointer over the
desired setting and click the mouse button.

When the Screen Saver is active, it will automatically darken the
screen after a period of mouse and keyboard inactivity. You can set
the number of minutes of inactivity in two ways. You can use the clock
icons on either side of the Screen Saver Delay slider as scroll
arrows, or you can drag the scroll bar. Release the mouse button when
the desired number displays in the scroll bar.

Modem Recognition allows you to choose whether or not you want the
Screen Saver to recognise modem activity. If the Modem Recognition is
on, the Screen Saver will recognise any modem activity amd will not
activate. If the Modem Recognition is off, the Screen Saver will
ignore modem activity and will activate after the set delay period of
keyboard and mouse activity has passed.
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4 Advanced Hard Disk Utilities

This appendix contains information about the Atari Advanced Bard Disk
Utilities disk. This disk contains programs and files that allow you
to:

Park and Un-park the read/write heads

Install or remove the hard disk driver file

Format and partition the hard disk

Erase the contents of a logical drive

Extend the system-wide folder limit

Mark bad sectors

Create an Bxtended Partition Scheme
You will not use these programs as part of the hard disk’s daily
operation. Instead, the programs allow you to start the drive for the
first time, perform functions that are required from time to time, or
saximise your use of the hard disk drive. This chapter will help you
choose the programs and utilities you need.

4.1 Parking and Unparking the Read/Write Heads

Whenever you move your computer, you should park the hard drive bheads
to prevent damage to the hard disk and the data it contains. Parking
the hard disk drive moves the read/write heads of the drive away from
the disk media. Parked heads cannot damage the disk wmedia during
moving or shipping. The Atari Advanced Hard Disk Utilities include two
types of head parking programs. Ome type parks the disk heads of all
hard drives connected to your system. The other parks the disk heads
of individual units.

Warning: If you fail to close all hard disk windows before parking the
drive heads you may damage data on your hard disk.

4.1.1 Parking Drive Heads on all Units

To park the hard disk drive heads on all hard disks connected to your
systes, run SHIP.PRG. You wmust run this program from a floppy disk in
drive A or B.

Note: SHIP.PRG will not park the heads of a Megafile 44 Removable Hard
Disk Drive,

With a directory of the Atari Advanced Hard Disk Utilities disk
displaying, follow these instructions to run SHIP.PRG.

1. Open the HDX folder.
2 Close all other open windows.
2. Run SHIP.PRG.
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4. Switch off your hard disk units as soon as the desktop appears.

4.1.2 Parking Drive Heads on Selected Units

To park a specific hard drive, you must select a physical unit to be
parked. With your hard disk utilities disk in drive A or B, follow
these instructions to park the heads on individual physical units:

L Run the HDX program.

2. Close all other open windows.

3. Select the Ship option on the Disk menu.

1

When the Select physical unit(s) dialogue box appears, select

the physical units that are to have their heads parked. Select
OK.

:&9 fou can select any physical wunit connected to your system
Hhom-mx& or not). The unit number boxes of connected devices appear
shadowed.

5. An alert box message appears on screen offering you a last
chance to cancel the head parking procedure.

Select OK to park the heads.

6. M. szmh alert box appears, instructing you to turn off your hard
isk.

Select OK and switch off the power to your disk drive(s).
Note: If you are preparing to move your entire system, switch off your
computer at this time.
4.1.3 Unparking the Drive Heads
The next time you start your system the drive heads are automatically
un-parked.
4.1.4 Installing and Removing Hard Disk Driver

The HINSTALL.PRG program installs or removes the hard disk driver
file. The hard disk driver allows you to start your system from your
hard drive. )

To install the Hard Disk Driver display the directory of the HINSTALL
folder and follow these steps:

L. Run HINSTALL.PRG
2. Select Install from the File menu.

3. Select a H.oﬁnm: drive for the operation. You can only select
logical drives that are highlighted in shadowed boxes. Select
OK.

{. From the displayed dialogue box, select OK to inmstall the
driver, or Cancel to abort the operation.
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To remove the Hard Disk Driver display the directory of the HINSTALL
folder and follow these steps:

1. Run HINSTALL.PRG
2. Select Remove from the File menu.

= Select a logical drive for the operation. You can only select
logical drives that are highlighted in shadowed boxes. Select
OK.

4. From the displayed dialogue box, select OK to install the
driver, or Cancel to abort the operation.

4.1.7 By-passing the Hard Disk Driver

As an alternative to removing the hard disk driver, you can simply
by-pass the driver. To do so, switch off your computer (or perforn a
keyboard cold-boot) and make sure there is a floppy in drive A that
does not contain a hard disk driver file. Switch on the systes. The
drive light comes on, and then goes off. Immediately hold down
[Alternate]. Release [Alternate] when the floppy drive’s busy light
goes back on.

4.2 Formatting the Hard Disk

Warning: The HDX Pormat and Partition options described in this

chapter completely erase all data on your hard disk. Back up all of

your valuable files before proceeding.

You will probably never have to re-format your hard disk. The hard

disk has already been formatted at the factory. Formatting the hard

disk creates wagnetic patterns called tracks and sectors. The process

also marks and logs bad sectors, areas on the disk with surface damage

or other imperfections. Data stored in these areas could be corrupted

or lost. During hard disk operations, the computer avoids sectors

marked and logged as bad. The formatting process also automatically

divides the hard disk into storage areas called partitions or logical

drives. You may need to format the hard disk if the factory format

becomes erased due to mishandling or if the hard disk develops bad

sectors.

Display the directory of the HDX folder. Follow these instructions to

format a hard disk:

1; Select HDY.PRG. Then select the FPormat option from the Disk
Eenu.

2 Read the alert wmessage that appears on screen. If necessary,
back up all your data before proceeding. Select OK to continue.

3. Select a physical unit (hard disk drive) for formatting. If you
are formatting only the internal hard disk, select UNIT 0. If
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you are formatting an additional hard disk, select a unit that
corresponds to the hard disk’s DIP m___:nu settings. (See your
hard disk drive owner’s wmanual for information about DIP switch
settings.) Units in shadowed boxes are the units that are
connected to your system.

M Select The Physical Unit A\

(| ({UNIT 8 ][ UNIT 1 ][ UNTT 7] [GNIT 1]
[UNIT 4 ][ UNIT S ] [UNIT ] [NIT 7]

o] [emce]

Select OK to continue. A dialogue box may appear, displaying a
list of hard disk unit types.

4. Select the hard disk type showing your drive’s model name.
Select OK to continue.

5. Read the alert message that appears on screen.

Select OK to format the unit. A message appears informing you that
formatting is in progress.

Note: When the partitioning message disappears, the formatting
operation is complete.

when formatting is complete, the Format option automatically initiates
the Markbad and Partitioning options. To find out more about these

functions, vrefer to the sections on Marking Bad Sectors and
Partitioning.

4.3 Partitioning the Hard Disk

Partitioning a hard disk is a process that divides the disk into
sections. Setting a partition size tells the hard drive how much
storage capacity to assign to each partition. You can use the
factory-set partition capacities or change the storage capacity of
each partition to suit your file organisation needs.

Partitioning divides your physical hard disk into data storage areas
called logical drives. Each logical drive is pre-installed and will
automatically appear on your desktop unless you re-partition the disk.
Partitioning allows you to store and access your data efficiently by
allowing you to group files and folders in different logical drives.

Use the Partition option to create partitions in sizes best suited to
your disk storage needs. The Partition option lets you use an editing

menu to set the size of each partition or select a suggested
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partitioning scheme without having to reformat your disk.

Note: When you re-partition your hard disk, you must use the Install
Devices command to install desktop icons for the logical drives.

4.3.1 Selecting a Unit to Partition

Display a directory of the HDX folder. Follow these instructions to
partition a hard disk:

1. Select HDX.PRG from the HDX folder. Then select the Partition
option from the Disk menu.

2. Select a physical unit for partitioning. To partition you hard
disk, select the unit number of the device you want to
partition. Only units in shadowed boxes can be selected. Select
OK to continue.

3 Select a partitioning scheme.

There are two ways to select a partitioning scheme. You can use the

Choose a Partition Scheme dialogue box to choose from preset

partitioning schemes or you can use the Edit Partition Scheme &&oﬁm

box to create a customised v&.nEo_Ea scheme. Minimum partition size
is 1 megabyte. Maximum partition size is determined by the capacity of
your hard disk.

The Expert option is shaded and camnot be selected unless you have

gore than four partitions. You need to use the Expert option only If

you plan to use more than one operating system.

4.3.2 Erasing the Contents of a Logical Drive

fou can erase all data from a selected logical drive 1;9 the Zero
option of the HDX program. Erasing (or zeroing) a logical drive 1is
useful if you want to clear the drive to make room for new data or if
you want to erase damaged data from a logical drive without
reformatting (and thus erasing) then entire hard disk.

4.4 Extending the System Wide Folder Limit

You can run POLDRIOO.PRG to extend the number of folders your systes
recognises. Though most users will be able to create as wmany folders
as they wish without problems, you can still use FOLDRI0O.PRG to
extend the folder limit even further.

To use this program, display the AUTO folder 93&02 on drive C
containing the POLDR100.PRG file. Then change the 100 in the filename
to any value between 001 and 999 using the Show Info option from the
Pile menu. The value you enter is the number of folders beyond 40 you
can now access. FPor example, to extend the limit to 240 folders, you
would change the filename to FOLDR240.PRG.

t me stored in the AUTO folder of the startup
The FOLDR program ®mus b




disk (partition C on the hard disk if physical unit 0 is the startup
disk). .

The new folder limit takes effect when you reboot your system. During
the boot procedure, a message appears that show how many extra folders
you have designated and how many bytes of RAM are allocated to the
extra folders. Each folder uses 132 bytes of RAM.

4.5 Marking Bad Sectors

Error messages stating that the data on your disk may be damaged might
indicate the presence of bad sectors on your disk. If such error
messages frequently appear, you should check your hard disk for bad
sectors. This process identifies and flags defective areas on the hard
disk. Hard disks may develop defective spots after the drive has been
in use. Once these spots have been logged with Markbad, they will not
be used for your hard disk operations.

The Atari Advanced Hard Disk Utilities disk includes two versions of
Markbad. One version is run automatically during the HDX Format
option. This version operates on the entire selected physical unit and
erases all data on the disk during formatting. The other version
operates on the selected logical drive when you run the HDX

Markbad option. This version helps you preserve data by letting you
decide whether or not to erase data containing bad sectors.

Both versions of Markbad display a log of any bad sectors found. The
cusulative tally of bad sectors in the log appears during subsequent
Harkbad operations.

Note: You can use the HDX Markbad option on hard disks formatted with
a previous version of HDX.

Display the directory of the HDX folder. Follow these steps to mark
bad sectors on selected logical drives:

1.  Select HDX.PRG. Then select the Markbad option from the Disk
Eenu.

2. select a logical drive from the Select the Logical Drive
dialogue box. Select OK to continue.

¥ While Markbad scans the logical drive for bad sectors, a message
appears telling you that the program is marking bad sectors. If
bad sectors are found in a file, select a course of action for
the file from the Logical Drive Markbad dialogue box. This box
displays the name of the file, the address location of the bad
sector and cluster in the logical drive, and your choices for a
course of action.

Note: The Logical Drive Markbad dialoque appears only when Markbad

flags bad sectors in all mmnmm clusters. An allocated cluster is a

cluster that has been assigned to a file.

A Logical Drive Markbad A

File
E:\SAMPLE.DOC

Bad sector: 627-
Cluster: 266_

[ Delete file |

Skip over bad sector
[ Tgnere bad sector |

select Delete Pile to erase the file or Skip Over Bad Sector to
preserve the undamaged portions of the file. Select Ignore Bad
Sector to leave the file unchanged. (Select Ignore Bad Sector if
you want to examine the file before taking action.)

If bad sectors are found in a sub directory file, select a
course of action for the sub directory from the Logical Drive
Markbad box. This box displays the name of the sub directory,
its address location, and your choices for a course of action.

1.  Select Delete Directory Only to delete the directory structure
and save the deleted directory files to the root directory. All
files saved to the root directory will be named "THPnnnn" where
"mnn® stands for the starting hexadecimal cluster address of
the file. Select Delete Directory And Piles to delete the
directory structure and all of its files. Select Ignore Bad
Sector if you don’t want to take anmy action at all.

Note: If a bad sector is found in a lost cluster, an alert box appears

giving you the option of marking the cluster. A lost cluster is a

sequent of data that is ‘unaccounted for and inaccessible to the

systen.

5.  When Markbad finishes scanning the disk, a Logical Drive Markbad
tally box with the total count of newly found bad sectors and
the count of all previously found bad sectors appears.

4.6 Organising and Maintaining your Hard Disk
The larger storage capacity of a hard disk wmeans that careful folder
and file organisation is more important than ever. When planning and
using your folder structure, keep the following tips in mind.
Use folder names that describe the types of files in the
folders. Keep files organised in folders so you can easily find




i iti dialogue box allows you
ton of the Edit Partition Scheme ogu :
H”m n”wwmwﬁ nﬂmmwgm_ow @ill contain the extended partition, and which of

four slots will contain standard partitions.

thea. The Select the Extended Partition m%m-mn.ﬂ.wwoﬁwmnhwﬂ M__,muﬁwm _WMM
Keep as few files as possible in the root directory. current 23:3..._ pattition mn_s-m.s ._._._mmﬂﬁ_uwﬂﬂ”:_:ﬁuﬂ size, and range
Keep the files you use wmost often in the Ffirst level of side of the .&.&oﬁm box Mguwa _uwzmso: i &.ﬂ_mo@m s a sibhe
directories. of each partition. ,__sm Exten €6 diiiie. onieh: elst Wil
. ; : right side of the dialogue box allows you to choo
Delete unneeded files to free up disk space for new fliles. contain the extended partition scheme. ]
4.7 Ow:.::unn Programs “ The Extended Partition Range dialogue box displays each slot’s range
An %:-:ﬁ. program checks the structure of your hard disk and of partitions. . . T
rearranges files and free space on the disk. The multiple sectors of In the example below, all four slots contain partition ;%m-m S.w
each file are grouped together. Contiguous free space is placed either The first slot contains partition one. The second slot con E_“”S:s
at the top of the disk (to increase the speed of writing new files to . A extended partition, which is subdivided as partitions two m:aam
the disk) or at the bottom of the disk (to increase the speed of eight. The partitions included in the ﬂwm.qa& ?ﬁ:uom M_“M moE,M__
accessing existing files). Back up your data, then use a file highlighted. The third slot includes partition E_s.am:m S
optimizer program reqularly to increase the speed and efficiency of slot contains partition ten. Slots one, ‘three a our
your hard disk drive and to reduce the possibility of data corruption standard partitions.
and loss.
Use one of the many hard disk optinizer progrars available through
your Atari dealer or Atari user groups.
- Partition  Extended Partitien Range
4.8 Extended Partition Schemes
Creating an extended partition scheme is an option for advanced users. |
You will probably never need to use this option in the norsal _
operation of your computer. s
There are four slots on your hard disk that keep track of partition "
information. You can fill each slot with a standard partition, and we__ M
have each partition represented on your desktop by a logical drive. Or Nﬂﬁ 6 eo1T) [k [CANcEL]
you can fill one of the four slots with an extended partition to
obtain more than four logical drives. : sgel- isk Files
An extended partition is subdivided into wmore than one partition. This 4.9 Other Advanced Hard .U_mr c:.:.gnwmn—u_mw
allous you to have more than one logical drive representing that slot. HDY.RSC is a GEM resource file used H.:. HDX. : s
Note: To store system startup data the first partition must be a A A WINCAP is a text file that includes information used by HDX.
standard partition. This partition is alvays assigned to the first AINSTALL.RSC is a GEM resource file used by HINSTALL.PRG
slot. You camnot select the first slot to contain the extended SHDRIVER.RAW is used with HINSTALL.PRG to create mmu_wzmx.wwwh
partition. You must use one of the three remaining slots to contain the hard disk driver file that directs your system to star
your extended partition. a hard disk.

Supporting T0S as your primary operating system, HDY.PRGC will

automatically choose slot number two to contain your extended

partition. However, if you plan to use more than one operating system,

it may be useful to choose the specifics of the partition assignments.

Some operating systems will not recognise an extended partition Page 37
scheme. The partitions you use with these operating systems must be

standard partitions.
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Appendix A
TOS 2.06 gives you the vowmwuw_mﬁ< to use special characters as 1, 4,

a, 1 and so on. You can get these special characters in the following
way: _
1. Press [Alternate|

2. Type on the numeric keyboard (the keys with the numbers on the
right side of the keyboard) the ASCII-code of the character you
want.

3. Release the alternate button.
c 128 u 129 & 138 § 13 o132 ) 113 i 1 .— ‘
m 135 g 136 é 137 & 118 i 119 i 148 1 141
142 R 143 £ 144 & 145 £ 146 8 147 ¥ 148
b 149 g 158 U 151 U 152 i 153 U 154 ¢ 155
£ 156 ¥ 157 p 158 f 159 § 160 { 161 é 162
i 163 i 164 R 165 a 166 8 187 L 168 - 169
. 178 k1 kK 171 1 173 « 1 » 175 i1
8 177 i 17 g 179 e 188 £ 181 ho182 i
i 184 185 186 TR q 188 8 189 8 1%
el | U 192 I 19 X194 1 195 1 1% 1197
n o198 1199 1 200 n 281 o 202 *om ) 184
? 185 o 286 1 187 o 788 128 128 1 211
7 n2 11Ul 8 114 R 215 1 216 1 U7 o218
1 219 1 128 § 221 A 12 « 121 « 224 p 225
r 126 v 127 I 228 o 279 u 218 T o21l ¢ 132
8 1211 2 1 § 115 $ 116 o 1217 € 118 n 119
s 248 t 241 r 242 $ M43 [ 244 1 s + 46
s 147 * 8 S 71 ] . 158 v 151 » 252 151
* 254 255
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